Abstract
This document describes removal and installation of field-replaceable units for Dot Hill AssuredSAN 4004 Series controller enclosures, and is intended for use by storage system administrators familiar with servers and computer networks, network administration, storage system installation and configuration, storage area network management, and relevant protocols.
# Contents

About this guide ................................................................. 7  
Overview ................................................................. 7  
AssuredSAN 4004 Series enclosure user interfaces ...................... 7  
Intended audience .......................................................... 7  
Prerequisites ............................................................... 7  
Related documentation .................................................... 8  
Document conventions and symbols ...................................... 8  
1 FRUs .......................................................... 10  
Available FRUs ........................................................... 10  
Storage enclosure overview .............................................. 10  
FRUs addressing 24-drive enclosures .................................. 11  
Enclosure bezel for 24-drive model .................................... 14  
Supported drive enclosures .............................................. 15  
FRUs addressing 12-drive enclosures .................................. 16  
Enclosure bezel for 12-drive model .................................... 19  
2 Procedures .................................................. 20  
Electrostatic discharge .................................................. 20  
Preventing electrostatic discharge ..................................... 20  
Grounding methods to prevent electrostatic discharge .............. 20  
Replacing chassis FRU components ................................... 21  
Attaching and removing the enclosure bezel ......................... 22  
Attaching the enclosure bezel ........................................ 22  
Removing the enclosure bezel ........................................ 22  
Replacing a controller module or expansion module ................. 23  
Before you begin ....................................................... 23  
Configuring partner firmware update .................................. 24  
Using the SMC or RAIDar ............................................. 24  
Using the CLI ......................................................... 24  
Verifying component failure ........................................... 25  
Stopping I/O ................................................................ 25  
Shutting down a controller module .................................... 26  
Using the SMC or RAIDar ............................................. 26  
Using the CLI ......................................................... 27  
Removing a controller module or expansion module ................ 27  
Transporting CompactFlash ............................................ 29  
Installing a controller module or expansion module ............... 29  
Verifying component operation ........................................ 30  
Using the SMC or RAIDar ............................................. 30  
Using the CLI ......................................................... 31  
Updating firmware ....................................................... 31  
Replacing a disk drive module .......................................... 32  
FDE considerations ....................................................... 32  
Air management modules ................................................ 33  
Before you begin ....................................................... 33  
Verifying component failure ........................................... 33  
Removing a disk drive module ........................................ 34  
Installing a disk drive module .......................................... 35  
Determine if a disk is missing ........................................... 36  
Using the SMC or RAIDar ............................................. 36  
Using the CLI ......................................................... 37  
Verifying component operation ........................................ 37  
Replacing a power supply module ...................................... 37
Before you begin ................................................................. 38
Verifying component failure ........................................... 38
Power supply units ......................................................... 39
   AC PSU ................................................................. 40
   DC and AC PSUs with power switch ......................... 41
Removing a power supply unit ....................................... 42
Installing a power supply unit ....................................... 43
Connecting a power cable ............................................. 44
Verifying component operation .................................... 45
Replacing ear components ............................................. 45
   Before you begin .................................................... 45
      2U24 chassis ears ................................................ 45
      2U12 chassis ears ................................................ 46
Removing ear components ............................................ 47
Installing ear kit components ....................................... 48
Verifying component operation .................................... 49
Transceivers used in CNC ports ................................... 49
Replacing a Fibre Channel transceiver ......................... 49
   Before you begin .................................................... 49
      Verifying component failure ................................. 50
      Removing an SFP module ...................................... 50
      Installing an SFP module ...................................... 50
      Verifying component operation ............................. 51
Replacing a 10GbE SFP+ transceiver ............................. 51
Replacing a 1Gb RJ-45 SFP transceiver ........................... 52
Replacing a storage enclosure chassis .......................... 53
   Before you begin .................................................... 53
      Verifying component failure ................................. 53
      Preparing to remove a damaged storage enclosure chassis ....... 53
      Removing a damaged storage enclosure chassis from the rack .... 54
      Installing the replacement storage enclosure in the rack ....... 55
      Completing the process ....................................... 56
      Verifying component operation ............................. 56
      Using LEDs ....................................................... 56
      Using management interfaces ................................ 57
Index ............................................................................ 58
Figures

1 Exploded view — controller or expansion enclosure (2U24) ...................................................... 12
2 4004 Series CNC controller module with SFP transceiver ....................................................... 13
3 Controller enclosure assembly with bezel installed (2U24) .................................................. 13
4 Controller enclosure architecture — internal components sub-assembly (2U24) .................. 13
5 Partial assembly showing bezel alignment (2U24) ................................................................. 14
6 Exploded view — controller or expansion enclosure (2U12) .................................................. 17
7 4004 Series CNC controller module with SFP transceiver ....................................................... 18
8 Enclosure assembly with bezel installed (2U12) ..................................................................... 18
9 Enclosure architecture — internal components sub-assembly (2U12) ........................................ 18
10 Partial assembly showing bezel alignment (2U12) ................................................................. 19
11 Partial assembly showing bezel alignment (2U24) ................................................................. 22
12 Partial assembly showing bezel alignment (2U12) ................................................................. 22
13 Disengaging a controller module ............................................................................................ 28
14 Extracting a controller module ................................................................................................ 28
15 Removing a controller module ................................................................................................. 28
16 CompactFlash memory card ..................................................................................................... 29
17 Inserting a controller module .................................................................................................... 30
18 Disengaging a disk drive module ............................................................................................. 34
19 Removing a disk drive module .................................................................................................. 35
20 Installing a disk drive module .................................................................................................. 35
21 AC PSU ..................................................................................................................................... 40
22 DC and AC PSUs with power switch ....................................................................................... 41
23 Removing a power supply unit ................................................................................................. 42
24 Orienting a power supply unit .................................................................................................. 43
25 DC power cable featuring D-shell and lug connectors ............................................................. 44
26 Replacing left ear components — 2U24 models .................................................................... 45
27 Replacing right ear components — 2U24 models ................................................................ 46
28 Replacing left ear components — 2U12 models ................................................................... 46
29 Replacing right ear components — 2U12 models ................................................................ 47
30 Sample SFP connector ............................................................................................................ 49
31 Disconnect fibre-optic interface cable from SFP .................................................................... 50
32 Flip SFP actuator upwards ....................................................................................................... 50
33 Install the SFP into the CNC port ............................................................................................ 51
# Tables

1. Related documents .......................................................... 8
2. Document conventions ..................................................... 8
3. Individual enclosure models comprising 4004 Series storage systems ........................................ 10
4. 4004 Series product components for 24-drive enclosures .............................................................. 11
5. Compatible drive enclosure options for adding storage ................................................................. 15
6. 4004 Series product components for 12-drive enclosures ................................................................. 16
7. Power supply faults and recommended actions .......................................................... 38
8. Power supply unit LED descriptions ........................................................................... 45
9. Removing and replacing a 10GbE SFP+ transceiver ...................................................... 51
10. Removing and replacing a 1 Gb SFP transceiver .................................................................. 52
11. Removing and replacing a storage enclosure chassis and its FRUs .................................. 54
About this guide

Overview

This guide identifies 4004 Series FRUs (field-replaceable units) used in 2U12 and 2U24 chassis form factors, and describes how to remove or install them within the AssuredSAN™ 4004 Series storage enclosure products listed below:

- CNC (Converged Network Controller) Controller enclosure (4824/4834 models):
  - Qualified Fibre Channel SFP option supporting (4/8/16 Gb)
  - Qualified Internet SCSI (10GbE) SFP option
  - Qualified Internet SCSI (1 Gb) Copper RJ-45 SFP option
- HD mini-SAS (12 Gb) Controller enclosure: 4524/4534

For a complete description of product models, see the “Components” chapter within the Setup Guide.

AssuredSAN 4004 Series enclosures support both traditional linear storage and new virtual storage, which uses paged-storage technology. For linear storage, a group of disks with an assigned RAID level is called a vdisk or linear disk group. For virtual storage, a group of disks with an assigned RAID level is called a virtual disk group. This guide uses the term vdisk when specifically referring to linear storage, and uses the term disk group otherwise.

AssuredSAN controller enclosures support compatible Dot Hill drive enclosures for adding storage. Supported enclosure form factors include traditional 2U models (2U12 and 2U24) and high-capacity models in 2U (2U48) and 4U (4U56) format. A summary overview of drive enclosures supported by controller enclosures is provided in the “Connecting the controller enclosure and drive enclosures” topic within the AssuredSAN 4004 Series Setup Guide.

AssuredSAN 4004 Series enclosure user interfaces

The 4004 Series enclosures support two versions of the web-based application for configuring, monitoring, and managing the storage system. Both web-based application GUI versions (v3 and v2), and the command-line interface are briefly described:

- Storage Management Console (SMC) is the new primary web interface (v3) for the enclosures, providing access to all common management functions for both linear and virtual storage.
- RAIDar is a secondary web interface (v2) for the enclosures, providing access to traditional linear storage functions. This legacy interface provides certain functionality that is not available in the primary interface.
- The command-line interface (CLI) enables you to interact with the storage system using command syntax entered via the keyboard or scripting. You can set a CLI preference to use v3 or v2 terminology in command output and system messages.

NOTE: For more information about enclosure user interfaces, see the following:
- AssuredSAN 4004 Series Storage Management Guide or online help
  The guide describes SMC (v3) and RAIDar (v2) GUIs
- AssuredSAN 4004 Series CLI Reference Guide

Intended audience

This guide is intended for storage system administrators.

Prerequisites

Prerequisites for installing and using this product include knowledge of:

- Servers and computer networks
• Network administration
• Storage system installation and configuration
• Storage area network (SAN) management and direct attach storage (DAS)
• Fibre Channel (FC), Internet SCSI (iSCSI), Serial Attached SCSI (SAS), and Ethernet protocols

Related documentation

Table 1 Related documents

<table>
<thead>
<tr>
<th>For information about</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancements, known issues, and late-breaking information not included in product documentation</td>
<td>Release Notes</td>
</tr>
<tr>
<td>Overview of product shipkit contents and setup tasks</td>
<td>Getting Started*</td>
</tr>
<tr>
<td>Regulatory compliance and safety and disposal information</td>
<td>AssuredSAN Product Regulatory Compliance and Safety*</td>
</tr>
<tr>
<td>Using a rackmount bracket kit to install an enclosure into a rack</td>
<td>AssuredSAN Rackmount Bracket Kit Installation* or AssuredSAN 2-Post Rackmount Bracket Kit Installation*</td>
</tr>
<tr>
<td>Product hardware setup and related troubleshooting</td>
<td>AssuredSAN 4004 Series Setup Guide</td>
</tr>
<tr>
<td>Obtaining and installing a license to use licensed features</td>
<td>AssuredSAN 4004 Series Obtaining and Installing a License</td>
</tr>
<tr>
<td>Using the v3 and v2 web interfaces to configure and manage the product</td>
<td>AssuredSAN 4004 Series Storage Management Guide</td>
</tr>
<tr>
<td>Using the command-line interface (CLI) to configure and manage the product</td>
<td>AssuredSAN 4004 Series CLI Reference Guide</td>
</tr>
<tr>
<td>Event codes and recommended actions</td>
<td>AssuredSAN Event Descriptions Reference Guide</td>
</tr>
</tbody>
</table>

* Printed document included in product shipkit.

For additional information, see Dot Hill’s Customer Resource Center web site: https://crc.dothill.com.

Document conventions and symbols

Table 2 Document conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue text</td>
<td>Cross-reference links and e-mail addresses</td>
</tr>
<tr>
<td>Blue, underlined text</td>
<td>Web site addresses</td>
</tr>
</tbody>
</table>
| Bold text  | • Key names  
|            | • Text typed into a GUI element, such as into a box  
|            | • GUI elements that are clicked or selected, such as menu and list items, buttons, and check boxes |
| Italic text | Text emphasis |
| Monospace text | • File and directory names  
|                | • System output  
|                | • Code  
|                | • Text typed at the command-line |
| Monospace, italic text | • Code variables  
|                        | • Command-line variables |
| Monospace, bold text | Emphasis of file and directory names, system output, code, and text typed at the command-line |
FRUs

Available FRUs

You can determine which FRUs pertain to your storage enclosure using the Command-line Interface (CLI). Access the controller via a Telnet client; log into the controller over the network (default user name manage and password !manage). If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the defaults shown above.

Enter a show frus query.

Execution of the show frus CLI command displays controller metadata, followed by the FRU information pertaining to chassis (with midplane), I/O modules (IOMs), and power supplies.


You can also determine which FRUs pertain to your storage enclosure by visual inspection of the component, noting serial number and part number. This method applies to disk drives. FRUs and FRU make-up are subject to change independent of documentation versions. Information about FRUs and other components can also be viewed via the SMC or RAIDar.


Storage enclosure overview

NOTE: Tables and companion illustrations show field-replaceable units for 4004 Series (2U24 and 2U12) products. FRUs used in 2U48 and 4U56 chassis are addressed in Ultra48 and Ultra56 documentation.

Table 3 provides summary descriptions of the individual controller enclosure models used by supported 4004 Series configurations.

Table 3 Individual enclosure models comprising 4004 Series storage systems

<table>
<thead>
<tr>
<th>AssuredSAN 4004 Series controller enclosure matrix</th>
<th>2.5” 24-drive Controller enclosures (SFF)</th>
<th>3.5” 12-drive Controller enclosures (LFF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Description</td>
<td>Form</td>
<td>Model Description</td>
</tr>
<tr>
<td>4824 Fibre Channel (8/16 Gb) SFP</td>
<td>2U24</td>
<td>4834 Fibre Channel (8/16 Gb) SFP</td>
</tr>
<tr>
<td>4824 Internet SCSI (10GbE) SFP</td>
<td>2U24</td>
<td>4834 Internet SCSI (10GbE) SFP</td>
</tr>
<tr>
<td>4824 Internet SCSI (1 Gb) SFP</td>
<td>2U24</td>
<td>4834 Internet SCSI (1 Gb) SFP</td>
</tr>
<tr>
<td>4524 HD mini-SAS (12 Gb)</td>
<td>2U24</td>
<td>4534 HD mini-SAS (12 Gb)</td>
</tr>
</tbody>
</table>

1This model uses a qualified FC SFP option within the CNC ports (used for host connection or replication). When in FC mode, the SFPs must be a qualified 8 Gb or 16 Gb fibre optic option. A 16 Gbit/s SFP can run at 16 Gbit/s, 8 Gbit/s, 4 Gbit/s, or auto-negotiate its link speed. An 8 Gbit/s SFP can run at 8 Gbit/s, 4 Gbit/s, or auto-negotiate its link speed.

2This model uses a qualified 10GbE iSCSI option within the controller module CNC ports (used for host connection or replication).

3This model uses a qualified 1 Gb iSCSI SFP option within the controller module CNC ports (used for host connection or replication).

4CNC ports support same-type or mixed-type SFPs in combination as described in Transceivers used in CNC ports on page 49.

5This model uses SFF-8644 connectors and qualified cable options for host connection.

Table 4 shows components for 2.5” 24-drive enclosure models (2U24). Table 6 on page 16 shows components for 3.5” 12-drive enclosure models (2U12). Tables and supporting illustrations (following tables) show components for the 4004 Series product line that can be ordered for replacement in the field. Contact your account manager for packaged FRU numbers and ordering information. Data addressing 4004 Series 24-drive and 12-drive enclosure products is provided to supplement the illustrated replacement
FRUs addressing 24-drive enclosures

The 2U24 chassis—configured with 24 2.5" disks—is used for 4004 Series controller enclosures and optional expansion enclosures.

Table 4  4004 Series product components for 24-drive enclosures

<table>
<thead>
<tr>
<th>Item</th>
<th>Enclosure component descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Disk drive (SFF)</td>
</tr>
<tr>
<td></td>
<td>a) 2.5&quot; disk drive module (disks of differing type/speed and storage capacity: SAS, SSD)</td>
</tr>
<tr>
<td></td>
<td>b) Air management module (blank to maintain optimum air flow within enclosure)</td>
</tr>
<tr>
<td>2</td>
<td>Ear kit</td>
</tr>
<tr>
<td></td>
<td>a) Left ear assembly</td>
</tr>
<tr>
<td></td>
<td>b) Right ear assembly</td>
</tr>
<tr>
<td></td>
<td>Also see Enclosure bezel for 24-drive model on page 14</td>
</tr>
<tr>
<td>3</td>
<td>Chassis (sheet metal flanges on internal IOM bay assembly are omitted from Figure 1 for visual clarity)</td>
</tr>
<tr>
<td>4</td>
<td>Midplane (included with chassis)</td>
</tr>
<tr>
<td>5</td>
<td>Power supplies (one shown)</td>
</tr>
<tr>
<td></td>
<td>a) AC power supply for enclosure (newer power supplies do not have a power switch)</td>
</tr>
<tr>
<td></td>
<td>b) DC power supply for enclosure</td>
</tr>
<tr>
<td>6</td>
<td>I/O module for enclosure (one shown, two allowed per enclosure)</td>
</tr>
<tr>
<td>7</td>
<td>Enclosure cover (included with chassis)</td>
</tr>
<tr>
<td></td>
<td>Controller module for enclosure [two allowed per controller enclosure] (see Figure 2 on page 13)</td>
</tr>
<tr>
<td></td>
<td>a) 4824, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option</td>
</tr>
<tr>
<td></td>
<td>b) 4824, 1RM, 4-port CNC, iSCSI [10GbE] SFP option</td>
</tr>
<tr>
<td></td>
<td>c) 4824, 1RM, 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option</td>
</tr>
<tr>
<td></td>
<td>d) 4524, 1RM, HD mini-SAS, 4-port [12 Gbit/s] SFF-8644 external connector</td>
</tr>
<tr>
<td></td>
<td>Small form-pluggable (SFP) connectors (see Figure 2 on page 13)</td>
</tr>
<tr>
<td></td>
<td>a) SFP transceiver (applies to CNC models only: FC, 10GbE iSCSI, 1 Gb iSCSI)</td>
</tr>
<tr>
<td>Not</td>
<td>Rail kits (variable options)</td>
</tr>
<tr>
<td>shown</td>
<td>a) Rack mount kit, shelf, short, All HW 22.5&quot; - 31&quot;</td>
</tr>
<tr>
<td></td>
<td>b) Rack mount kit, shelf, long, All HW 25&quot; - 36&quot;</td>
</tr>
<tr>
<td></td>
<td>c) Rack mount bracket kit, 2-Post adjustable, All HW</td>
</tr>
<tr>
<td>Not</td>
<td>Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]</td>
</tr>
<tr>
<td>shown</td>
<td>Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]</td>
</tr>
<tr>
<td></td>
<td>Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]</td>
</tr>
<tr>
<td>Not</td>
<td>Cable kit [Cable package: USB Type B; CLI (USB)]</td>
</tr>
<tr>
<td>shown</td>
<td>AC power cord compatible with AC power supply unit; or</td>
</tr>
<tr>
<td></td>
<td>DC power cable compatible with DC power supply unit</td>
</tr>
</tbody>
</table>
**NOTE:** Numbered items from Table 4 are shown in Figure 1. Tinted items from Table 4 are shown in Figure 2 on page 13.

**Figure 1** Exploded view — controller or expansion enclosure (2U24)

*Figure 1* through *Figure 5* illustrate 24-drive enclosure models. Item No.6 (above) is a supported expansion module. *Figure 2* shows a newer 4004 Series controller module also supported by the enclosure. Although not shown in *Figure 1*, newer product models use an enclosure bezel instead of ear caps (no longer used). The enclosure bezel is shown in *Figure 5* on page 14 (removed) and in *Figure 3* on page 13 (installed), respectively.

**NOTE:** The following illustrations further describe Table 4 components for the 24-drive chassis:

- Controller module pictorial — *Figure 2*
- Assembly — *Figure 3* on page 13 and *Figure 5* on page 14
- Internal components sub-assembly — *Figure 4* on page 13
Figure 2 4004 Series CNC controller module with SFP transceiver

The controller module shown in Figure 2 is used instead of the expansion module (item No.6 in Figure 1) when the chassis is configured as a controller enclosure, rather than an expansion enclosure. The transceiver is shown exploded from the IOM in the CNC example. Controller modules equipped with CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Figure 3 Controller enclosure assembly with bezel installed (2U24)

Figure 4 Controller enclosure architecture — internal components sub-assembly (2U24)
Enclosure bezel for 24-drive model

The SFF 24-drive enclosure supports a bezel sub-assembly that attaches to the front of the chassis (see Figure 5). The bezel—comprised of a vented cover featuring integrated ear caps—is pre-assembled and packed with foam into a box included in the master shipping container.

**NOTE:** The enclosure bezel geometry shown in illustrations within this document may be slightly different than the bezel shipped with your product, but the ball stud attachment points are the same.

Bezel attachment and removal instructions are provided beneath Attaching and removing the enclosure bezel on page 22.

![Figure 5](image)

**Figure 5** Partial assembly showing bezel alignment (2U24)
Supported drive enclosures

<table>
<thead>
<tr>
<th>Model</th>
<th>Form</th>
<th>Enclosure description</th>
<th>Disk drives</th>
<th>Rear panel connection</th>
<th>NEBS</th>
</tr>
</thead>
<tbody>
<tr>
<td>J6G24</td>
<td>2U24</td>
<td>24-drive 6 Gbit/s chassis with FRUs</td>
<td>2.5” (SFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 5</td>
</tr>
<tr>
<td>J6G12</td>
<td>2U12</td>
<td>12-drive 6 Gbit/s chassis with FRUs</td>
<td>3.5” (LFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 5</td>
</tr>
<tr>
<td>J6G48</td>
<td>2U48</td>
<td>48-drive 6 Gbit/s chassis with FRUs</td>
<td>2.5” (SFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 5</td>
</tr>
<tr>
<td>J6G56</td>
<td>4U56</td>
<td>56-drive 6 Gbit/s chassis with FRUs</td>
<td>3.5” (LFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 5</td>
</tr>
</tbody>
</table>

1These 4004 Series-compatible expansion enclosure models feature 6 Gbit/s internal disk and SAS expander link speeds.
2See the AssuredSAN Ultra48 Series Setup and FRU I&R Guides for information about the high-capacity 2U48 chassis form factor.
3See the AssuredSAN Ultra56 Series Setup and FRU I&R Guides for information about the high-capacity 4U56 chassis form factor.
4See the 4004 Series Setup Guide for maximum enclosure limits and associated cabling configurations.
5The 4004 Series and Ultra56 Series—which includes the J6G56—are designed for NEBS compliance, but the 3004 Series and Ultra48 Series—which includes the J6G48—are not.
6Reference documents for the J6G48 (2U48) and J6G56 (4U56) are listed below.
7See http://www.dothill.com for most current information concerning support of drive enclosures for storage expansion.

Within the AssuredSAN 4004 Series product line, the 2U12 and 2U24 chassis can be configured as either a controller enclosure or a drive enclosure for adding storage. These enclosures look very similar to one another. For a given from factor (2U12 or 2U24) only the IOM geometry differs: either it is a controller module or an expansion module. The remaining FRUs for a given chassis are common.

Within the AssuredSAN 4004 Series product line, the high-capacity 2U48 chassis is supported as an expansion enclosure (J6G48) for adding storage to 2U12 or 2U24 controller enclosures.

**IMPORTANT:** For illustrations and information about the 2U48 chassis—which is supported as a drive enclosure option for 4004 Series controller enclosures—refer to the following related documents:
- AssuredSAN Ultra48 Series Setup Guide
- AssuredSAN Ultra48 Series FRU Installation and Replacement Guide
- AssuredSAN Ultra48 Rackmount Bracket Kit Installation

Within the AssuredSAN 4004 Series product line, the high-capacity 4U56 chassis is supported as an expansion enclosure (J6G56) for adding storage to 2U12 or 2U24 controller enclosures.

**IMPORTANT:** For illustrations and information about the 4U56 chassis—which is supported as a drive enclosure option for 4004 Series controller enclosures—refer to the following related documents:
- AssuredSAN Ultra56 Series Setup Guide
- AssuredSAN Ultra56 Series FRU Installation and Replacement Guide
- AssuredSAN Ultra56 Rackmount Bracket Kit Installation
- AssuredSAN Ultra56 Enclosure Bezel Kit Installation
### FRUs addressing 12-drive enclosures

The 2U12 chassis—configured with 12 3.5" disks—is used for 4004 Series controller enclosures and optional expansion enclosures.

**Table 6** 4004 Series product components for 12-drive enclosures

<table>
<thead>
<tr>
<th>Item</th>
<th>Enclosure component descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Disk drive (LFF)</td>
</tr>
<tr>
<td></td>
<td>a) 3.5&quot; disk drive module (disks of differing type/speed and storage capacity: SAS, SSD)</td>
</tr>
<tr>
<td></td>
<td>b) Air management module (blank to maintain optimum air flow within enclosure)</td>
</tr>
<tr>
<td>2</td>
<td>Ear kit</td>
</tr>
<tr>
<td></td>
<td>a) Left ear assembly</td>
</tr>
<tr>
<td></td>
<td>b) Right ear assembly</td>
</tr>
<tr>
<td></td>
<td>Also see Enclosure bezel for 12-drive model on page 19</td>
</tr>
<tr>
<td>3</td>
<td>Chassis</td>
</tr>
<tr>
<td>4</td>
<td>Midplane (included with chassis)</td>
</tr>
<tr>
<td>5</td>
<td>Power supplies (one shown)</td>
</tr>
<tr>
<td></td>
<td>a) AC power supply for enclosure (newer power supplies do not have a power switch)</td>
</tr>
<tr>
<td></td>
<td>b) DC power supply for enclosure</td>
</tr>
<tr>
<td>6</td>
<td>Expansion module (one shown)</td>
</tr>
<tr>
<td></td>
<td>J6G12, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]</td>
</tr>
<tr>
<td>7</td>
<td>Enclosure cover (included with chassis)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Enclosure component descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Controller module for enclosure [two allowed per controller enclosure] (see Figure 7 on page 18)</td>
</tr>
<tr>
<td></td>
<td>a) 4834, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option</td>
</tr>
<tr>
<td></td>
<td>b) 4834, 1RM, 4-port CNC, iSCSI [10GbE] SFP option</td>
</tr>
<tr>
<td></td>
<td>c) 4834, 1RM, 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option</td>
</tr>
<tr>
<td></td>
<td>d) 4534, 1RM, HD mini-SAS, 4-port [12 Gbit/s] SFF-8644 external connector</td>
</tr>
<tr>
<td></td>
<td>Small form-pluggable (SFP) connectors (see Figure 7 on page 18)</td>
</tr>
<tr>
<td></td>
<td>a) SFP transceiver (applies to CNC models only: FC, 10GbE iSCSI, 1 Gb iSCSI)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Rail kits (variable options)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a) Rack mount kit, shelf, short, All HW 22.5&quot; - 31&quot;</td>
</tr>
<tr>
<td></td>
<td>b) Rack mount kit, shelf, long, All HW 25&quot; - 36&quot;</td>
</tr>
<tr>
<td></td>
<td>c) Rack mount bracket kit, 2-Post adjustable, All HW</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]</td>
</tr>
<tr>
<td></td>
<td>Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]</td>
</tr>
</tbody>
</table>

| Item | Cable kit [Cable package: USB Type B; CLI (USB)] |

| Item | AC power cord compatible with AC power supply unit; or DC power cable compatible with DC power supply unit |
NOTE: Numbered items from Table 6 are shown in Figure 6. Tinted items from Table 6 are shown in Figure 7 on page 18.

Figure 6 Exploded view — controller or expansion enclosure (2U12)

Figure 6 through Figure 10 illustrate 12-drive enclosure models. Figure 8 on page 18 provides an assembly of the exploded view shown in Figure 6, and Figure 9 on page 18 shows an assembly of component FRUs within the enclosure. Although not shown in Figure 6, newer product models use an enclosure bezel instead of ear caps (no longer used). The enclosure bezel is shown in Figure 10 on page 19 (removed) and Figure 8 on page 18 (installed), respectively.

NOTE: The following illustrations further describe components for the 12-drive chassis:
• Controller module pictorial — Figure 7 on page 18
• Assembly — Figure 8 on page 18 and Figure 10 on page 19
• Internal components sub-assembly — Figure 9 on page 18
Figure 7 4004 Series CNC controller module with SFP transceiver

The controller module shown in Figure 7 is used instead of the expansion module (item No.6 in Figure 6) when the chassis is configured as a controller enclosure, rather than an expansion enclosure. The transceiver is shown exploded from the IOM in the CNC example. Controller modules equipped with CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Figure 8 Enclosure assembly with bezel installed (2U12)

Figure 9 Enclosure architecture — internal components sub-assembly (2U12)
Enclosure bezel for 12-drive model

The LFF 12-drive enclosure supports a bezel sub-assembly that attaches to the front of the chassis (see Figure 10). The bezel—comprised of a vented cover attached to an EMI (Electromagnetic Interference) shield—is pre-assembled and packed with foam into a box included in the master shipping container. The bezel might optionally include a removable air filter that can be serviced or replaced. Hard copy instructions for attaching/removing the bezel, and for servicing or replacing the air filter, are provided in the shipping container of a new enclosure.

Alternatively, you can access the document online. See Dot Hill’s customer resource center (CRC) web site for additional information: https://crc.dothill.com.

NOTE: The enclosure bezel geometry shown in illustrations within this document may be slightly different than the bezel shipped with your product, but the ball stud attachment points are the same.

Basic bezel attachment and removal instructions are provided beneath Attaching and removing the enclosure bezel on page 22.

Figure 10 Partial assembly showing bezel alignment (2U12)

NOTE: For more information about servicing or replacing the removable air filter option for this particular bezel, refer to the AssuredSAN 12-drive Enclosure Bezel Kit Installation instructions included in your product ship kit.

IMPORTANT: For information about compatible drive enclosures supported by 4004 Series 12-drive controller enclosures using the 2U12 chassis, see Supported drive enclosures on page 15.
2 Procedures

This chapter provides procedures for replacing FRUs (field-replaceable units), including precautions, removal instructions, installation instructions, and verification of successful installation. Each procedure addresses a specific task. Certain procedures refer to related documentation. See Related documentation on page 8 for a list of these documents and where to find them online.

**IMPORTANT:** Procedures pertain to FRUs used in 4004 Series (2U24 and 2U12) products. Procedures pertaining to FRUs used in 2U48 and 4U56 chassis are addressed in Ultra48 and Ultra56 documentation.

Electrostatic discharge

Before you begin any of the procedures, consider the following precautions and preventive measures.

Preventing electrostatic discharge

To prevent electrostatic discharge (ESD) from damaging the system, be aware of the precautions to consider when setting up the system or handling parts. A discharge of static electricity from a finger or other conductor may damage system boards or other static-sensitive devices. This type of damage may reduce the life expectancy of the device.

**CAUTION:** Parts can be damaged by electrostatic discharge. Follow these precautions:

- Avoid hand contact by transporting and storing products in static-safe containers.
- Keep electrostatic-sensitive parts in their containers until they arrive at static-protected workstations.
- Place parts in a static-protected area before removing them from their containers.
- Avoid touching pins, leads, or circuitry.
- Always be properly grounded when touching a static-sensitive component or assembly.
- Remove clutter (plastic, vinyl, foam) from the static-protected workstation.

Grounding methods to prevent electrostatic discharge

Several methods are used for grounding. Adhere to the following precautions when handling or installing electrostatic-sensitive parts.

**CAUTION:** Parts can be damaged by electrostatic discharge. Use proper anti-static protection:

- Keep the replacement FRU in the ESD bag until needed; and when removing a FRU from the enclosure, immediately place it in the ESD bag and anti-static packaging.
- Wear an ESD wrist strap connected by a ground cord to a grounded workstation or unpainted surface of the computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm (± 10 percent) resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.
- If an ESD wrist strap is unavailable, touch an unpainted surface of the chassis before handling the component.
- Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when standing on conductive floors or dissipating floor mats.
- Use conductive field service tools.
- Use a portable field service kit with a folding static-dissipating work mat.
If you do not have any of the suggested equipment for proper grounding, have an authorized reseller install the part. For more information about static electricity or assistance with product installation, contact an authorized reseller.

Replacing chassis FRU components

Chassis FRUs replace a damaged chassis or chassis components. A fully functional chassis requires successful installation of the following components:

- One or two controller modules of the same model (for a given controller enclosure)*
  See Replacing a controller module or expansion module on page 23 for more information.
- All disk drives and air management modules
  See Replacing a disk drive module on page 32 for more information.
- Two power supply modules of the same type (both AC or both DC)
  See Replacing a power supply module on page 37 for more information.
- Two ears with components installed (complementary left and right ear kits)
  See Replacing ear components on page 45 for more information

**NOTE:** Newer product models use an enclosure bezel instead of ear covers.
- See Figure 11 on page 22 for 2U24 enclosure bezel alignment.
- See Figure 12 on page 22 for 2U12 enclosure bezel alignment.

- One or two expansion modules of the same model (per optional expansion enclosure)*
  See Replacing a controller module or expansion module on page 23 for more information.

*For enclosures equipped with a single I/O module (IOM), the lower IOM slot within the chassis is empty, and must be covered with an IOM blank to allow optimum air flow through the enclosure during operation.

In addition to the FRUs identified above, replacement procedures are provided to address specific interface protocols and replacement of the enclosure chassis:

- Removal and installation of a Fibre Channel transceiver
  See Replacing a Fibre Channel transceiver on page 49 more information.
- Removal and installation of a 10GbE SFP+ transceiver
  See Replacing a 10GbE SFP+ transceiver on page 51 for more information.
- Removal and installation of a 1 Gb RJ-45 SFP transceiver
  See Replacing a 1Gb RJ-45 SFP transceiver on page 52 for more information.
- Removal and installation of a storage enclosure chassis
  See Replacing a storage enclosure chassis on page 53 for more information.

Replacement of chassis FRU components are described within this chapter.

**NOTE:** AssuredSAN 4004 Series controller enclosures support hot-plug replacement of redundant controller modules, fans, power supplies, and I/O modules. Hot-add of drive enclosures is also supported.

**TIP:** Many procedures refer to component LEDs and LED statuses. See the AssuredSAN 4004 Series Setup Guide for descriptions of model-specific front panel and rear panel LEDs.

**TIP:** Within the AssuredSAN 4004 Series Setup Guide, see “Troubleshooting > Fault isolation methodology” for information about using health icons/values—in addition to using LEDs—for verifying component failure before actually replacing the FRU.
Attaching and removing the enclosure bezel

Before accessing front panel LEDs, you must first remove the enclosure bezel.

**Figure 11** Partial assembly showing bezel alignment (2U24)

**Figure 12** Partial assembly showing bezel alignment (2U12)

Attaching the enclosure bezel

1. Orient the bezel to align its back side with the front face of the enclosure as shown in the figures above.
2. Face the front of the enclosure, and while supporting the base of the bezel, position it such that the mounting sleeves within the integrated ear caps align with the ball studs.
3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the enclosure.

Removing the enclosure bezel

1. While facing the front of the enclosure, insert the index finger of each hand into the top of the respective (left or right) pocket opening shown in the figures above.
2. Insert the middle finger of each hand into the bottom of the respective opening, with thumbs on the bottom of the bezel face.
3. Gently pull the top of the bezel while applying slight inward pressure below, to release the bezel from the ball studs.
Replacing a controller module or expansion module

In a dual-controller configuration, controller and expansion modules are hot-swappable, which means you can replace one module without halting I/O to disk groups, or powering off the enclosure. In this case, the second module takes over operation of the storage system until you install the new module.

You may need to replace a controller module or an expansion module when:

- The Fault/Service Required LED is illuminated
- Health status reporting in the SMC or RAIDar indicates a problem with the module
- Events in the SMC or RAIDar indicate a problem with the module
- Troubleshooting indicates a problem with the module

**NOTE:** 4004 Series controller enclosures equipped with CNC controller modules support the optionally-licensed AssuredRemote™ replication feature; whereas enclosures equipped with SAS controller modules do not.

**IMPORTANT:** Although you can view information about replication sets in the SMC and RAIDar, and by using the CLI, you must use RAIDar or the CLI to perform replications using the optionally-licensed AssuredRemote feature.

**CAUTION:** When replacing a 4004 Series controller set supporting AssuredRemote with a 4004 Series controller set that does not support this licensed feature, you must first delete all replication sets before swapping the controller modules. Not doing so will lead to unexpected results, and there is no way to delete replication sets after the installation. See the following for additional information:

- AssuredSAN 4004 Series Storage Management Guide
- AssuredSAN 4004 Series CLI Reference Guide

**Before you begin**

Removing a controller or expansion module from an operational enclosure significantly changes air flow within the enclosure. Openings must be populated for the enclosure to cool properly. Leave modules in the enclosure until ready to install a replacement. For controller enclosures configured with a single controller module, a companion IOM blank must be properly installed in the bottom controller module slot.

Single-controller enclosures can be upgraded to dual-controller status. If replacing the controller module in a single-controller enclosure, or if replacing both controllers in a dual-control enclosure, use the SMC or RAIDar to record configuration settings before installing the new controller modules. See Removing a controller module or expansion module on page 27, and Installing a controller module or expansion module on page 29 for instructions on installing an additional controller module.

**CAUTION:** When replacing a controller module, ensure that less than 10 seconds elapse between inserting it into a slot and fully latching it in place. Not doing so might cause the controller to fail. If it is not latched within 10 seconds, remove the controller module from the slot, and repeat the process.

When two controller modules are installed in the enclosure, they must be of the same model type. When replacing both controller modules in an operational enclosure, follow these guidelines:

1. Replace one controller as described in these instructions.
2. Wait 30 minutes: this pause ensures that the controller and its ownership of vdisks or disk groups has sufficient time to stabilize (also see Verifying component operation on page 30).
3. Check the system status and event logs to verify that the system is stable.
4. Replace the partner controller as described in these instructions.
Configuring partner firmware update

In a dual-controller system in which Partner Firmware Update (PFU) is enabled, when you update firmware on one controller, the system automatically updates the partner controller. Disable partner firmware update only if requested by a service technician.

Use the SMC, RAIDar, or the CLI to change the PFU setting.

Using the SMC or RAIDar

IMPORTANT: See the “Updating firmware” topic within the AssuredSAN 4004 Series Storage Management Guide before performing a firmware update.

To change the PFU setting using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. Click in the System panel in the banner, and select Action > Update Firmware.
   The Update Firmware panel opens. The Update Controller Modules tab shows versions of firmware components that are currently installed in each controller.

   NOTE: The SMC does not provide a check-box for enabling or disabling Partner Firmware Update for the partner controller. To enable or disable the setting, use the set advanced-settings command, and set the partner-firmware-upgrade parameter. See the CLI Reference Guide for more information about command parameter syntax. Also see Using the CLI on page 24.

To change the PFU setting using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. Click in the Configuration View panel, right-click the system and select Configuration > Advanced Settings > Firmware.
3. Either select (check) the Partner Firmware Update check box to enable the option, or clear the check box to disable the option.
4. Click Apply.

Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages.

TIP: The following CLI commands enable you to set the management mode to v3 or v2:

- Use set protocols to change the default management mode.
- Use set cli-parameters to change the current management mode for the CLI session.

The system defaults to v3 for new customers and v2 for existing users (see the CLI Reference Guide for more information).

1. Log-in to the command-line interface using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. To verify that partner firmware upgrade is enabled, run the following command:
   show advanced-settings
3. If partner firmware upgrade is disabled, enable it by running the following command:
   set advanced-settings partner-firmware-upgrade enabled


Verifying component failure

Select from the following methods to verify component failure:

- Use the SMC or RAIDar to check the health icons/values of the system and its components to either ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar use health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
- As an alternative to using the SMC or RAIDar, you can run the show system command in the CLI to view the health of the system and its components. If any component has a problem, the system health will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
- Monitor event notification — With event notification configured and enabled, use the SMC or RAIDar to view the event log, or use the CLI to run the show events detail command to see details for events.
- Check Fault/Service Required LED (back of enclosure): Amber = Fault condition
- Check that the FRU OK LED (back of enclosure) is off

Stopping I/O

When troubleshooting disk drive and connectivity faults, stop I/O to the affected disk groups from all hosts and remote systems as a data protection precaution. As an additional data protection precaution, it is helpful to conduct regularly scheduled backups of your data.

IMPORTANT: Stopping I/O to a disk group is a host-side task, and falls outside the scope of this document.

When on-site, you can verify that there is no I/O activity by briefly monitoring the system LEDs; however, when accessing the storage system remotely, this is not possible. Remotely, you can use the show disk-group-statistics command to determine if input and output has stopped. Perform these steps:

1. Using the CLI, run the show disk-group-statistics command.
   The Number of Reads and Number of Writes outputs show the number of these operations that have occurred since the statistic was last reset, or since the controller was restarted. Record the numbers displayed.

2. Run the show disk-group-statistics command a second time.
   This provides you a specific window of time (the interval between requesting the statistics) to determine if data is being written to or read from the disk. Record the numbers displayed.

3. To determine if any reads or writes occur during this interval, subtract the numbers you recorded in step 1 from the numbers you recorded in step 2.
   • If the resulting difference is zero, then I/O has stopped.
   • If the resulting difference is not zero, a host is still reading from or writing to this disk group. Continue to stop I/O from hosts, and repeat step 1 and step 2 until the difference in step 3 is zero.

Shutting down a controller module

Shutting down the Storage Controller in a controller module ensures that a proper failover sequence is used, which includes stopping all I/O operations and writing any data in write cache to disk. If the Storage Controller in both controller modules is shut down, hosts cannot access the system’s data. Perform a shut down before you remove a controller module from an enclosure, or before you power off its enclosure for maintenance, repair, or a move.

⚠️ CAUTION: You can continue to use the CLI when either or both Storage Controllers are shut down, but information shown might be invalid.

Use the SMC, RAIDar, or the CLI to perform a shut down.

Using the SMC or RAIDar

To shut down using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown.
2. In the System panel in the banner, click and select Restart System.
   The Controller Restart and Shut Down panel opens.
3. Select the Shut Down operation, which automatically selects the controller type Storage.
4. Select the controller module to shut down: A, B, or both.
5. Click OK. A confirmation panel appears.
6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

   NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.

To shut down using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart Controller.
   The Shut Down or Restart Controller panel appears.
3. In the Shut Down or Restart Controller panel, set the options:
   • Operation: select Shut down.
   • Controller type: select Storage.
   • Within the Controller field, select A, B, or Both.
4. Click Shut down now. A confirmation dialog appears.
5. Click Yes to continue; otherwise, click No. If you clicked Yes, a second confirmation dialog appears.
6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

   NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.

NOTE: See AssuredSAN 4004 Series Storage Management Guide for additional information.
Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.

1. Log-in to the CLI using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. In a dual-controller system, verify that the partner controller is online by running the command:
   show controllers
3. Shut down the failed controller—A or B—by running the command:
   shutdown a or shutdown b
   The blue OK to Remove LED (back of enclosure) illuminates to indicate that the controller module can be safely removed.
4. Illuminate the identification LED of the enclosure that contains the controller module to remove by running the command:
   set led enclosure 0 on

**NOTE:** See AssuredSAN 4004 Series CLI Reference Guide for additional information.

Removing a controller module or expansion module

**IMPORTANT:**
- In a single-controller configuration, if you desire to transport CompactFlash to a replacement controller, remove the controller module only after the cache is copied to CompactFlash, which is indicated by the Cache Status LED being off (see Transporting CompactFlash on page 29).
- In a single-controller environment, you must stop I/O and power off the enclosure before replacing the controller module.
- In a dual-controller environment, you may hot-replace a single controller module in an operational enclosure, provided you first shut down the faulty controller using the SMC, RAIDar, or the CLI.
- In a dual-controller environment—if replacing both controller modules—you must adhere to the instructions provided in Before you begin on page 23.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” page 20.

**NOTE:** Within these procedures, illustrations featuring controller module face plates are generic. They do not show host interface ports, and they pertain to all 4004 Series controller module models. For illustrations of model-specific controller face plates, see the AssuredSAN 4004 Series Setup Guide.

Illustrations in the controller module replacement procedures show rear panel views of the enclosure, and IOMs are properly aligned for insertion into the rear panel of the enclosure.

1. Verify that you have successfully shut down the controller module using the SMC, RAIDar, or the CLI.
2. Locate the enclosure whose Unit Locator LED (front right ear) is illuminated, and within the enclosure, locate the controller module whose OK to Remove LED is blue (rear panel).
3. Disconnect any cables connected to the controller.
   Label each cable to facilitate re-connection.
4. Turn the thumbscrews counterclockwise until they disengage from the controller (see Figure 13 on page 28).
5. Press both latches downward to disconnect the controller module from the midplane (see Figure 14).

6. Pull the controller module straight out of the enclosure such that the controller module remains level during removal (see Figure 15).
Transporting CompactFlash

This action applies to single-controller configurations only. To prevent data loss in single-controller configurations, the CompactFlash must be moved from the failed controller module to the new controller module.

⚠️ **CAUTION:** Do not transport CompactFlash in dual-controller environments. Doing so could cause data corruption.

Confirm that transporting CompactFlash is the appropriate action to take as specified in the AssuredSAN 4004 Series Setup Guide. Refer to Figure 16 when performing the step-procedure that follows.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.

**Controller module pictorial**
(Midplane-facing rear view)

![Figure 16 CompactFlash memory card](image)

1. Locate the CompactFlash memory card at the midplane-facing end of the failed controller module.
2. Grip the CompactFlash memory card and carefully pull it from the slot in the failed controller module.
3. Label the CompactFlash memory card as Data, and set it aside for safekeeping.
4. Locate the replacement controller module, and carefully remove its installed CompactFlash memory card. Take care not to confuse this disc with the one labeled Data.
5. Align the CompactFlash memory card labeled Data for insertion into the replacement controller module—then insert it into the slot—and push it forward until seated in place.

Installing a controller module or expansion module

💡 **TIP:** You can install a controller module into an enclosure that is powered on, provided you wait 60 seconds after removing the old controller module. Check controller and midplane power connectors before inserting the new controller module into the enclosure.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.

1. Loosen the thumbscrews; press the latches downward (see Figure 17 on page 30).
2. Ensuring that the controller module is level, slide it into the enclosure as far as it will go (1).
A controller module that is only partially-seated will prevent optimal performance of the controller enclosure. Verify that the controller module is fully-seated before continuing.

3. Press the latches upward to engage the controller module (2); turn the thumbscrews clockwise until finger-tight.

4. Reconnect the cables.

### NOTE:
See the AssuredSAN 4004 Series Setup Guide for cabling information.

![Figure 17 Inserting a controller module](image)

**IMPORTANT:** In a dual-controller system in which PFU is enabled, when you update firmware on one controller, the system automatically updates the partner controller.

### Verifying component operation

After replacing the controller module, verify that the FRU OK LED (rear panel) illuminates green, indicating that the controller has completed initializing, and is online/operating normally. It may take two to five minutes for the replacement controller to become ready. If you are replacing either controller module, and PFU is enabled, you may need to wait 30 minutes to ensure that the two controllers—with their respective ownership of the disk groups—have enough time to fully stabilize.

**IMPORTANT:** Use the SMC, RAIDar, or the CLI to perform a restart only if necessary. See the “Restarting controllers” topic in the Storage Management Guide for more information.

### Using the SMC or RAIDar

To restart the controller using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown.

2. In the System panel in the banner, click and select Restart System.
   The Controller Restart and Shut Down panel opens.
3. Select the Restart operation.
4. Select the controller type to restart: Management or Storage.
5. Select the controller module to shut down: A, B, or both.
6. Click OK. A confirmation panel appears.
7. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

**NOTE:** If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.

To restart the controller using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage. If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart Controller.
3. In the main panel, set the options:
   - Operation: Select Restart.
   - Controller Type: Select the controller type to restart: Management or Storage.
   - Controller: Select the controller module to restart: A, B, or Both.
4. Click Restart now. A confirmation panel appears.
5. Click Yes to continue; otherwise, click No. If you click Yes, a second confirmation diagram appears.
6. Click Yes to continue; otherwise, click No. If you click Yes, a message describes restart activity.

**NOTE:** If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: A connection to the target was lost, but Initiator successfully reconnected to the target.

**Using the CLI**

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.

If the enclosure’s Unit Locator LED is on, run the following command to turn it off:

```
set led enclosure 0 off
```

If the Fault/Service Required LED is amber, the controller module has not gone online, and likely failed its self-test. Put the module online by restarting the controller, or by checking the event log for errors.

To restart the Management Controller (A or B), run the following command:

```
restart mc a or restart mc b or restart mc both
```

To restart the Storage Controller (A or B), run the following command:

```
restart sc a or restart sc b or restart sc both
```

**TIP:** See the AssuredSAN 4004 Series Setup Guide for descriptions of model-specific LEDs.

**Updating firmware**

You can view the current versions of firmware in controller modules, expansion modules (in drive enclosures), and disks, and you can also install new firmware versions.
**TIP:** To ensure success of an online update, select a period of low I/O activity. This helps the update complete as quickly as possible and avoids disruptions to hosts and applications due to timeouts. Attempting to update a storage system that is processing a large I/O-intensive batch job will likely cause hosts to lose connectivity with the storage system.

A controller enclosure can contain one or two controller modules. In a dual-controller system, both I/O modules (IOMs) should run the same firmware version. Storage systems in a replication set must run compatible firmware versions. You can update the firmware in each IOM by loading a firmware file obtained from the enclosure vendor.

If you have a dual-controller system and the PFU option is enabled, when you update one controller, the system automatically updates the partner controller. If PFU is disabled, after updating firmware on one controller, you must log into the partner controller’s IP address and perform this firmware update on that controller also.

**NOTE:** If a vdisk (v2) or disk group (v3) is quarantined, firmware update is not permitted due to the risk of losing unwritten data that remains in cache for the vdisk or disk group. Before you can update firmware, you must resolve the problem causing the quarantine, as described in the Storage Management Guide, online help, or the CLI Reference Guide (see `dequarantine` CLI command).

For best results, the storage system should be in a healthy state before starting firmware update. You can update firmware using the SMC, RAIDar, or by using FTP (File Transfer Protocol). See the Storage Management Guide for more information.

**IMPORTANT:** See the “Updating firmware” topic within the AssuredSAN 4004 Series Storage Management Guide before performing a firmware update.

---

**Replacing a disk drive module**

A disk drive module consists of a disk in a sled. Disk drive modules are hot-swappable, which means they can be replaced without halting I/O to the disk groups, or powering off the enclosure. The new disk drive module must be of the same type, and possess capacity equal to or greater than the one being replaced. Otherwise, the storage system cannot use the new disk to reconstruct the disk group.

**FDE considerations**

The Full Disk Encryption feature available via the management interfaces requires use of self-encrypting drives (SED) which are also referred to as FDE-capable disk drive modules. When installing FDE-capable disk drive modules, follow the same procedures for installing disks that do not support FDE. The exception occurs when you move FDE-capable disk drive modules for one or more disk groups to a different system, which requires additional steps.

The procedures for using the FDE feature, such as securing the system, viewing disk FDE status, and clearing and importing keys are performed using the SMC, RAIDar, or CLI commands (see the 4004 Series version of the Storage Management Guide or CLI Reference Guide for more information).

**NOTE:** When moving FDE-capable disk drive modules for a disk group, stop I/O to the disk group before removing the disk drive modules. Import the keys for the disks so that the disk content becomes available.

While replacing or installing FDE-capable disk drive modules, consider the following:

- If you are installing FDE-capable disks drive modules that do not have keys into a secure system, the system will automatically secure the disks after installation. Your system will associate its existing key with the disks, and you can transparently use the newly-secured disks.
• If the FDE-capable disk drive modules originate from another secure system, and contain that system’s key, the new disks will have the Secure, Locked status. The data will be unavailable until you enter the passphrase for the other system to import its key. Your system will then recognize the metadata of the disk group and incorporate it. The disks will have the status of Secure, Unlocked and their contents will be available:
  • To view the FDE status of disks, use the SMC, RAIDar, or the `show fde-state` CLI command.
  • To import a key and incorporate the foreign disks, use the SMC, RAIDar, or the `set fde-import-key` CLI command.

  **NOTE:** If the FDE-capable disks contain multiple keys, you will need to perform the key importing process for each key to make the content associated with each key become available.

• If you do not want to retain the disks’ data, you can repurpose the disks. Repurposing disks deletes all disk data, including lock keys, and associates the current system’s lock key with the disks.
To repurpose disks, use the SMC, RAIDar, or the `set disk` CLI command.
• You need not secure your system to use FDE-capable disks. If you install all FDE-capable disks into a system that is not secure, they will function exactly like disks that do not support FDE. As such, the data they contain will not be encrypted. If you decide later that you want to secure the system, all of the disks must be FDE-capable.
• If you install a disk module that does not support FDE into a secure system, the disk will have the Unusable status and will be unavailable for use.
• If you are re-installing your FDE-capable disk drive modules as part of the process to replace the chassis-and-midplane FRU, you must insert the original disks and re-enter their FDE passphrase.

**Air management modules**

An air management module looks like a disk drive module; however, it is an empty box—also known as a blank—and it is used to maintain optimal air flow for proper cooling within the enclosure. Air management modules are installed in slots missing disk drive modules. If you must remove a disk drive module, but cannot immediately replace it, you must either leave the faulty module in place, or insert an air management module in its place.

The blank is installed using the same procedure as Installing a disk drive module on page 35. Similarly, the blank is removed using the same procedure as Removing a disk drive module on page 34.

**Before you begin**

⚠️ **CAUTION:** Removing a disk drive module impacts the airflow and cooling ability of the enclosure. If the internal temperature exceeds acceptable limits, the enclosure may overheat and automatically shut down or restart. To avoid potential overheating, wait 20 seconds to allow the internal disks to stop spinning, then insert the new disk drive module.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.

**Verifying component failure**

Before replacing a disk, perform the following steps to ensure that you have correctly identified the module requiring removal and replacement.

⚠️ **CAUTION:** Failure to identify the correct disk drive module could result in data loss if the wrong disk is removed from the enclosure. If your enclosure has a bezel installed, remove it to view disk LEDs. Alternatively, you can observe disk component health via the SMC or RAIDar.
When a disk drive fault occurs, the failed disk’s fault indicator LED, located on the enclosure’s front panel, illuminates solid amber (see the AssuredSAN 4004 Series Setup Guide for a description of LEDs and disk drive slot numbering for your enclosure). You can determine from visual inspection which disk in the enclosure is experiencing a fault/failure using the fault LED for your disk type.

NOTE: Newer product models use an enclosure bezel instead of ear covers.
- See Figure 11 on page 22 for 2U24 enclosure bezel alignment.
- See Figure 12 on page 22 for 2U12 enclosure bezel alignment.

Alternatively, you can observe disk component health using management interfaces to verify component failure or component operation (see Using management interfaces on page 57 for more information).

Removing a disk drive module

1. Follow one of two sub-steps below, according to your product disk drive module type (see Figure 18):
   a. SFF disk (stands on edge) — Squeeze the latch release flanges together to disengage the disk drive module, and swing the pivoting portion of the latch upwards by 45° (see Figure 18 and Figure 19 on page 35).
   b. LFF disk (lays on side) — Slide the release latch to the left to disengage the disk drive module (see Figure 18).

   Moving the latch to the left will provide a clicking sound and cause the spring to move its position inside the chassis, partially ejecting the disk from its installed position within the disk drive slot.

   ![Figure 18 Disengaging a disk drive module](image)

2. Wait 20 seconds for the internal disks to stop spinning.

3. Follow one of the two sub-steps below, according to your product disk drive type (see Figure 19 on page 35):
   a. SFF disk — Firmly grasp the front of the plastic sled, and pull the disk drive module straight out of the chassis, taking care not to drop the module.
   b. LFF disk — Once the disk drive module partially ejects from the slot, grasp the module firmly, and carefully pull it straight out of the chassis slot. Take care not to drop the module.
Installing a disk drive module

1. Follow one of the two sub-steps below, according to your product disk drive module type:
   a. SFF disk — Squeeze the latch release flanges together, and then pull the latch, rotating it upward until it is fully open (see Figure 18 on page 34 and Figure 19).
   b. LFF disk — No action required. Proceed to step 2 below.

2. Follow one of the two sub-steps below, according to your product disk drive module type:
   a. SFF disk — With the LEDs oriented to the bottom, slide the disk drive module into the drive slot as far as it will go (see left illustration in Figure 20).
   b. LFF disk — With the LEDs oriented to the left, slide the disk drive module into the drive slot as far as it will go (see right illustration in Figure 20).

3. Follow one of the two sub-steps below, according to your product’s disk drive type:
   a. SFF disk — Rotate the latch downward until it clicks closed to firmly seat the disk drive module in the enclosure midplane.
   b. LFF disk — Verify that you have inserted the disk drive module into the slot as far as it will go, to ensure that the module is firmly seated in the enclosure midplane.

The installed disk drive module should now appear as shown in Figure 18 on page 34.
NOTE: Allow at least 30 seconds to elapse when jointly completing the “Removing a disk drive module” and “Installing a disk drive module” procedures.

If using the SMC, execute steps 4 - 6 to complete this procedure. If using RAIDar, execute steps 7 and 8 to complete this procedure. If using the CLI, execute steps 9 and 10 to complete this procedure.

**Using the SMC (v3):**

4. Sign in to the SMC (use default user manage and password !manage, or the appropriate username and password if they have been changed).
5. Click the **System** topic. The System panel opens.
6. Click the **Table** tab to determine whether the health of the new disk is OK. If the health is OK, then the disk drive module installation process is complete. If the health is not OK, then hover over the disk to display details about it, such as Status and Health Recommendations.

**Using RAIDar (v2):**

7. Sign in to RAIDar (use default user manage and password !manage, or the appropriate username and password if they have been changed).
8. View the System Overview panel to determine whether the health of the new disk is OK. If the health is OK, then the disk drive module installation process is complete. If the health is not OK, then in the Configuration View panel, select the enclosure that the new disk is in to display the Enclosure Overview panel, and select the disk to view details about it, such as Status and Health Recommendations.

**Using the CLI:**

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.

9. Log in to the CLI (use default user manage and password !manage, or the appropriate username and password if they have been changed).
10. To view information about disks, run the following command:

    ```
    show disks <disk-ID>
    ```

    Disks are specified by enclosure ID and slot number. Enclosure IDs increment from 0. Disk IDs increment from 0 in each enclosure (e.g., show disks 0.7). Entering the command shown in parenthesis will display the disk health for the disk residing in slot number 7 of enclosure number 0 (i.e., the controller enclosure). If health is not OK, the command output will also display recommended actions.

**Determine if a disk is missing**

You can determine whether a disk is missing by using management interfaces.

**Using the SMC or RAIDar**

To determine whether a disk is missing by using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.

2. Click the **System** topic. The System panel opens.
   - Select the **Front** tab to display a pictorial representation of disks within slots, and hover over individual disks to view the metadata such as location, usage, tier, type, and size.
   - You can hover over enclosure ears to see metadata for specific enclosures in the system.
   - Select the **Table** tab to display a tabular view of information about physical components in the system.

3. Using the Front and Table views, look for gaps in the disk location sequence to determine if a disk is missing.
To determine whether a disk is missing by using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure
   login credentials instead of the system defaults shown above.
2. In the Configuration View panel, right-click the appropriate enclosure under Physical.
   • Select the Front Graphical tab to display a pictorial representation of disks within slots, and the
     supporting enclosure table showing properties and values.
   • Select the Front Tabular tab to display the Enclosure’s Front View data table and supporting
     enclosure table showing properties and values.
3. Using the graphical and tabular views, look for gaps in the disk location sequence to determine if a
   disk is missing.

Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages.
See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.

1. Log-in to the command-line interface (CLI) using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure
   login credentials instead of the system defaults shown above.
2. To determine location of a missing or faulty drive, run the following command:
   show disks
   The command outputs a listing of detected disks’ properties by location. Review the information, and
   look for gaps in the disk location sequence to determine whether any disks are missing.

Verifying component operation

Verify that the Power/Activity LED—located on the front face of the disk drive escutcheon—is illuminated
green. On LFF disks, this is the bottom LED. On SFF disks, this is the left LED. Both sets of LEDs are shown in
Figure 20 on page 35.

\[\textbf{TIP: }\] See the AssuredSAN 4004 Series Setup Guide for descriptions of disk drive LEDs and other front
panel LEDs pertaining to 2U12 and 2U24 controller enclosures.

Also see Using management interfaces on page 57 as an alternative to physically observing LEDs to verify
component operation.

Replacing a power supply module

This section provides procedures for replacing a failed AC or DC power supply module, also referred to as
a power supply unit (PSU). Illustrations in power supply module replacement procedures show rear panel
views of the enclosure, and PSUs are properly aligned for insertion into the rear panel of the enclosure.
A single PSU is sufficient to maintain operation of the enclosure. You need not halt operations and
completely power-off the enclosure when replacing only one PSU; however, a complete shutdown is
required if replacing both power supply units.

\[\textbf{CAUTION: }\] Power supply FRU replacement activities can cause enclosure cables to disconnect and disks
to go offline. Be careful with cabling connections during FRU replacement.

If immediate replacement is necessary during I/O, ensure that all cables are securely fastened, and
proceed with caution as you replace the power supply FRU within the controller enclosure. Be very careful
if moving a cabled/operational enclosure during the FRU replacement process.
Verifying component failure

You can observe power supply component health (PSUs, fans) using LEDs, management interfaces, or a combination thereof to verify component failure or component operation (see Using management interfaces on page 57 for more information).

When either a fan or power supply component fails, the SMC or RAIDar provide notification; faults are recorded in the event log; and the PSU’s status LED color changes to amber to indicate a fault condition.

Table 7 describes menu navigation using the SMC (v3) or RAIDar (v2). The shorthand v3 and v2 prefixes are used to distinguish between the GUI product versions supported by 4004 Series enclosures.

Table 7 also references a CLI command. You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.

Table 7  Power supply faults and recommended actions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Power supply fan warning or failure, or power supply warning or failure  | • v3: Verify that all fans are working using the SMC. Click the System tab within the topics pane and from the System topic, select the Rear tab. Hover over each power supply module to view health attributes. You can also select the Table tab and view health status for power supply modules and other components in tabular form.  
  • v2: Verify that all fans are working using RAIDar. In the Configuration View, expand Physical, right-click the enclosure and select View > Overview. Select either Rear Graphical or Rear Tabular to view health attributes.  
  • Optionally, you can verify that all fans are working using the CLI. The show fans command will output health status for fans in the specified enclosure.  
  • Ensure that the power supply modules are properly seated and secured within their slots.  
  • Ensure that no slots are left open for more than two minutes. If you must replace the FRU, leave the old module in place until the replacement arrives to maintain optimal airflow and avoid overheating. |
| Event code 551 or 168                                                   |                                                                                                              |
| Power supply module failure status, or voltage event notification      | • Verify that the power supply module is powered on. If your power supply module has a power switch, verify that it is switched on.  
  • Verify that the power cables are securely attached to the power supply module and the appropriate power source. |
| Event code 554, 551, or 168                                             |                                                                                                              |
Alternatively, you can observe power supply component health (PSUs, fans) using management interfaces to verify component failure or component operation (see Using management interfaces on page 57 for more information).

### Power supply units

4004 Series enclosures feature two redundant power supplies: either both AC or both DC. Each DC power supply is equipped with a power switch. Some AC power supplies used with compatible storage enclosures have a power switch, whereas others do not. This characteristic varies by model type and vintage.

**IMPORTANT:** Many AC power supply units do not have power switches. These PSUs power on when connected to a power source, and power off when disconnected.

Power cycling procedures vary according to the type of power supply module included with the enclosure. For controller and expansion enclosures configured with AC PSUs that do not have power switches, refer to the procedure described under AC PSU on page 40. For procedures pertaining to a) enclosures configured with DC PSUs, or b) previously installed expansion enclosures featuring power switches, see DC and AC PSUs with power switch on page 41.

**NOTE:** AC PSUs—with or without a power switch—are compatible with one another in that the two different models can coexist in the same enclosure, and are interchangeable, provided they are of the same form factor/physical size and power rating.

4004 Series enclosures support high-capacity (J6G48 and J6G56) drive enclosures in addition to the J6G12 (2U12) and J6G24 (2U24) drive enclosures for adding storage. See the “Connecting the controller enclosure and drive enclosures” topic within the AssuredSAN 4004 Series Setup Guide for details.

**NOTE:** 4004 Series controllers support high-capacity drive enclosures for adding storage:

**IMPORTANT:** The 4U chassis uses an altogether different power supply unit than the model used for 2U enclosures described herein. This applies to both AC and DC PSUs. See the Ultra56 user documents listed above for details about power supply modules—and respective procedures—used with the 4U56 chassis.
Enclosures configured with AC PSUs that do not have a power switch rely on the power cord for power cycling. Connecting the cord from the PSU power cord connector to the appropriate power source facilitates power on; whereas disconnecting the cord from the power source facilitates power off.

**Figure 21  AC PSU**

**Powering off the PSU**

1. Stop all I/O from hosts to the enclosure (see *Stopping I/O* on page 25).

   ☏️ **TIP:** This step is *not* required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

   Given that power switch shut-off does not apply to this particular power supply model, proceed to disconnecting the AC power cord.

   ☏️ **TIP:** This step is *not* required for hot-swapping; however, it is required when replacing both PSUs.

   Given that power switch shut-off does not apply to this particular power supply model, proceed to disconnecting the AC power cord.

**Disconnecting an AC power cord**

1. Disconnect the power cord’s male plug from the power source.

2. Disconnect the power cord’s female plug from the power cord connector on the PSU.

**NOTE:** See *Connecting a power cable* on page 44 for an illustration showing AC power cord connection/disconnection.
Powering off the PSU

1. Stop all I/O from hosts to the enclosure (see Stopping I/O on page 25).

   **TIP:** This step is not required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

   **TIP:** This step is not required for hot-swapping; however, it is required when replacing both PSUs.

3. If applicable, turn off the power switch on the PSU being replaced and on the replacement PSU.

Disconnecting an AC power cord

1. If applicable, verify that the power switch on the PSU being replaced is in the **Off** position.
2. Disconnect the power cord’s male plug from the power source.
3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

   **NOTE:** See Connecting a power cable on page 44 for illustrations showing both AC and DC power cord connection/disconnection.

Disconnecting a DC power cable

1. Verify that the power switch on the PSU being replaced is in the **Off** position.
2. Loosen the cable-locking screws that attach each D-shell connector to its power supply, and carefully disconnect the lugs on each cable wire component of the DC power cable from the DC power source (Figure 25 on page 44 shows cable wire lugs and D-shell connector).
3. Loosen the cable-locking screws attaching the D-shell connector to the PSU, and disconnect the power cable from the PSU.
Removing a power supply unit

1. If replacing a single power supply module via hot-swap, proceed to step 3.
2. If replacing both power supply modules, verify that the enclosure is powered off.
   If the PSU model has a power switch, verify that the switch is set to the **Off** position.
3. Verify that the power cord is disconnected.
4. Turn the thumbscrew at the top of the latch counterclockwise to loosen and disengage it from the module; however, do not remove the thumbscrew from the latch.
5. Rotate the latch downward by approximately 45°, supplying sufficient leverage to disconnect the module from the internal connector.
   See Figure 23 below.

6. Use the latch to pull the module straight out of the chassis slot, taking care to support the base of the PSU—with both hands—as you remove it from the enclosure.
7. If replacing two power supply modules, repeat step 3 through step 6.

⚠️ **CAUTION:** Do not lift the module by its latch; doing so could damage the latch. Using both hands, lift and carry the module using its metal casing.
Installing a power supply unit

To install a power supply module, perform the following steps:

1. Orient the PSU with the AC or DC power cable connector toward the right as shown in Figure 23 on page 42 and Figure 24, respectively.
2. With the latch in the open position, ensure that the power supply module is level, and slide it into the appropriate power supply slot as far as it will go.
3. Rotate the PSU latch upward until it is flush against the PSU face, ensuring that the connector on the PSU engages the connector inside the chassis.
4. Turn the thumbscrew located at the top of the power supply latch clockwise, until it is finger-tight, to secure the latch to the power supply unit within the enclosure.
5. If replacing two power supply modules, repeat step 1 through step 4.

**NOTE:** AC PSUs—with or without a power switch—are compatible with one another in that the two different models can coexist in the same enclosure, and are interchangeable, provided they are of the same form factor/physical size and power rating.
Connecting a power cable

This section addresses power cable connection for enclosures configured with either AC or DC power supply modules.

Connecting an AC power cord

The diagram at right pertains to AC PSU models (a switchless unit is shown).

1. Install the power cord:
   a. Connect the female plug to the AC PSU cord inlet.
   b. Connect the male plug to the rack power source.
   Verify connection of the primary power cord(s) from the rack to separate external power sources.

2. Power-on the newly-installed PSU:
   • Connecting the power cord effectively powers a switchless AC PSU on. Wait several seconds for the disks to spin up.
   • For AC PSUs equipped with a power switch, press the power switch to the **On** position. Wait several seconds for the disks to spin up.

3. If replacing two power supply modules, repeat step 1 and step 2.

Connecting a DC power cable

Locate the DC power cable that applies to the DC PSU being installed in the enclosure.

1. Install the appropriate DC power cable:
   a. Connect a DC power cable to each DC power supply using the D-shell connector. Use the **UP>** arrow on the connector shell to ensure proper positioning (see adjacent left side view of D-shell connector).
   b. Tighten the screws at the top and bottom of the shell, applying a torque between 1.7 N-m (15 in-lb) and 2.3 N-m (20 in-lb), to securely attach the cable to the DC PSU.
   c. To complete the DC connection, secure the other end of each cable wire component of the DC power cable to the target DC power source. Check the three individual DC cable wire labels before connecting each cable wire lug to its power source. One cable wire is labeled ground (GND), and the other two are labeled positive (+L) and negative (-L), respectively (see Figure 25 above).

2. If you did not perform a hot-swap, power-on storage system components in the order indicated:
   Expansion enclosures first; controller enclosures next; data host last (if powered down for maintenance).

![Figure 25 DC power cable featuring D-shell and lug connectors](image-url)
Verifying component operation

Examine PSU module status as indicated in the table below.

### Table 8  Power supply unit LED descriptions

<table>
<thead>
<tr>
<th>LED No./Description</th>
<th>Color</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 — Input Source Power Good</td>
<td>Green</td>
<td>On</td>
<td>Power is on and input voltage is normal.</td>
</tr>
<tr>
<td>1 — Input Source Power Good</td>
<td></td>
<td>Off</td>
<td>Power is off, or input voltage is below the minimum threshold.</td>
</tr>
<tr>
<td>2 — Voltage/Fan Fault/</td>
<td>Amber</td>
<td>On</td>
<td>Output voltage is out of range, or a fan is operating below the minimum required RPM.</td>
</tr>
<tr>
<td>Service Required</td>
<td></td>
<td>Off</td>
<td>Output voltage is normal.</td>
</tr>
</tbody>
</table>

LEDs for a PSU are located in the top right corner of the module face, as shown in Figure 24 on page 43. The top LED corresponds to LED number (1) above, and the bottom LED corresponds to number (2) above. If the Voltage/Fan Fault/Service Required LED is illuminated amber, the PSU module has not gone online, and likely failed its self-test. Remove and reinstall the PSU module. In addition to viewing the PSU LEDs, verify that the cooling fans are spinning. Also see Using management interfaces on page 57 as an alternative to physically observing LEDs to verify component operation.

Replacing ear components

Before you begin

⚠️ **CAUTION:**  Verify that you have the proper FRU kit (left or right) for the ear components being replaced.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.

Enclosure ear kit FRUs are available for the left and right ears of the chassis front panel. The following replacement procedure applies to ear kits provided with the 2U24 and 2U12 enclosure models, respectively. Refer to the following illustrations pertaining to your product ear kit. Illustrations in ear kit replacement procedures show front panel views of each enclosure, and ear bezel components are properly aligned for attachment to the ears on the front panel of the enclosure.

2U24 chassis ears

Figure 26 shows the left ear flange of a 2U24 model with the LED circuit board installed. The enclosure bezel is removed to reveal the left ear and SFF disks. See Attaching and removing the enclosure bezel on page 22 (Figure 11) for bezel attachment and removal details.

Left ear with bezel removed
(disk drives shown)
Figure 27 shows the right ear flange of a 2U24 model. The enclosure bezel is removed to reveal the right ear. The example uses an empty 2U24 chassis. The LED circuit board is shown exploded from its installed position, and aligned with the light pipe sub-assembly, which is integral to the enclosure bezel.

![Right ear explosion (empty chassis shown)](image)

**Figure 27** Replacing right ear components — 2U24 models

The enclosure bezel attaches to four ball studs on the front of the enclosure: each 2U24 ear flange hosts two ball studs. Relative to both left and right ear kits for 2U24 models, see Removing ear components on page 47 and Installing ear kit components on page 48.

2U12 chassis ears

Figure 28 shows the left ear flange of a 2U12 model with the LED circuit board installed. The enclosure bezel is removed to reveal the left ear and LFF disks. See Attaching and removing the enclosure bezel on page 22 (Figure 12) for bezel attachment and removal details.

![Left ear with bezel removed](image)

**Figure 28** Replacing left ear components — 2U12 models

Figure 29 on page 47 shows the right ear flange of a 2U12 model. The enclosure bezel is removed to reveal the right ear and LFF disks. The LED circuit board is shown exploded from its installed position, and aligned with the light pipes, which are integral to the enclosure bezel. Individual light pipes are shown exploded from the front of the enclosure bezel.
The enclosure bezel attaches to four ball studs on the front of the enclosure: each 2U12 ear flange hosts two ball studs. Relative to both left and right ear kits for 2U12 models, see Removing ear components and Installing ear kit components on page 48.

**TIP:** If your 2U12 enclosure is equipped with a bezel that employs an optional air filter, refer to the Enclosure Bezel Kit Installation document—included in your product shipkit—for instructions on servicing the air filter.

### Removing ear components

See Figure 26 on page 45 (2U24 chassis), Figure 27 on page 46 (2U24 chassis), Figure 28 on page 46 (2U12 chassis), and Figure 29 (2U12 chassis) when removing the enclosure bezels.

1. Stop all I/O from hosts to the system.
2. Use management software to shut down any other components necessary.
3. Power off the enclosure.
4. Remove the enclosure bezel:
   - See Figure 11 on page 22 and supporting narrative for 2U24 enclosure bezel removal.
   - See Figure 12 on page 22 and supporting narrative for 2U12 enclosure bezel removal.
5. On the target ear, loosen the two screws securing the LED circuit board to the threaded mounting sleeves. Use a No.2 Phillips screw driver.

**NOTE:** With the exception of the right ear on the 2U24 chassis, the mounting sleeves protrude forward from the ear flange. On 2U24 chassis, an angle bracket is affixed to the front of the right ear, with mounting sleeves protruding rightward from the base of the angle bracket.

Remove the screws and retain them for use when installing the new LED circuit board.

6. Remove the ESD cage protecting the LED circuit board, and retain it for reinstallation:
• This step applies to left ear kit replacement only: see Figure 26 on page 45 for 2U24 enclosures.
• This step applies to left ear kit replacement only: see Figure 28 on page 46 for 2U12 enclosures.

7. Disconnect the flexible ribbon cable from the back of the LED circuit board.
   a. Pull gently on the LED circuit board to stretch the ribbon cable attached to the back of the board.
   b. Reach behind the LED circuit board, and slightly pull outward on the locking mechanism of the connector to release the flexible ribbon cable from the circuit board.

8. Remove the LED circuit board.
   Figure 26 on page 45 shows the left ear circuit board and LEDs of 2U24 enclosures.
   Figure 27 on page 46 shows the right ear circuit board and LEDs of 2U24 enclosures.
   Figure 28 on page 46 shows the left ear circuit board and LEDs of 2U12 enclosures.
   Figure 29 on page 47 shows the right ear circuit board and LEDs of 2U12 enclosures.

Installing ear kit components
Refer to the appropriate target ear illustration when installing ear kit components for your product:

• See Figure 26 on page 45 for left ear components on 2U24 enclosures.
• See Figure 27 on page 46 for right ear components on 2U24 enclosures.
• See Figure 28 on page 46 for left ear components on 2U12 enclosures.
• See Figure 29 on page 47 for right ear components on 2U12 enclosures.

1. Locate the replacement LED circuit board for the target ear.
2. Verify that the enclosure is powered off.
3. Install the LED circuit board for each target ear:
   a. Properly orient the replacement LED circuit board, and align it for installation onto the ear flange as shown in the pertinent illustration (see bullet list above).
   
   **NOTE:** With the exception of the right ear on the 2U24 chassis, the mounting sleeves protrude forward from the ear flange. On 2U24 chassis, an angle bracket is affixed to the front of the right ear, with mounting sleeves protruding rightward from the base of the angle bracket.

   b. Release the locking mechanism on the ribbon cable connector located on the back of the LED circuit board.
   c. While holding the flexible ribbon cable steady, insert it into the connector on the back of the LED circuit board, and push in on the locking mechanism to secure the cable connection.
   d. Locate the ESD cage and align its through-holes with those on the LED circuit board:
      • This step applies to left ears only: see Figure 26 on page 45 for 2U24 enclosures.
      • This step applies to left ears only: see Figure 28 on page 46 for 2U12 enclosures.
   e. Locate the LED circuit board fastener screws that you previously removed, and insert a screw through each of the board’s two mounting holes, and into the threaded hole of the sleeve.
   f. Take care to ensure that the screw threads correctly mesh with the threads in the hole—in order to avoid cross-threading or stripping—and hand tighten them. If a calibrated torque driver is available, torque each screw to 3 in./lbs.
   g. Verify that the LED circuit board is securely installed, and the flexible ribbon cable is fully-seated into the connector, and locked in place.

4. Gently slip the enclosure bezel cover onto the push-fit mounting ball studs, taking care to guide the LED indicators through the bezel’s ear covers.
5. Power on the enclosure.

**TIP:** See the AssuredSAN 4004 Series Setup Guide for descriptions of front panel LEDs.
Verifying component operation

Enclosure status LEDs are located on the front of the controller enclosure. During normal operation, the FRU OK and Temperature Fault LEDs are green, and the other status LEDs located on the right ear are off.

Transceivers used in CNC ports

AssuredSAN 4824/4834 models use Converged Network Controller (CNC) technology, allowing you to select the desired host interface protocol from available Fibre Channel (FC) or Internet SCSI (iSCSI) host interface protocols supported by the system. You can use the CLI to set all controller module CNC ports to use one of these host interface protocols: 16 Gbit/s FC; 8 Gbit/s FC; 10GbE iSCSI; or 1 Gbit/s iSCSI.

Alternatively, you can use the CLI to set CNC ports to support a combination of host interface protocols. When configuring a combination of host interface protocols, host ports 0 and 1 must be set to FC (either both 16 Gbit/s or both 8 Gbit/s), and host ports 2 and 3 must be set to iSCSI (either both 10GbE or both 1 Gbit/s), provided the CNC ports use the qualified SFP connectors and cables required for supporting the selected host interface protocol. CNC ports can be used for host connection or remote replication, provided the optional AssuredRemote™ feature is licensed.

**IMPORTANT:** To change the host port mode for CNC ports, follow the “Change the host port mode” instructions provided in the AssuredSAN 4004 Series Setup Guide.

Replacing a Fibre Channel transceiver

This section provides steps for replacing a small form-factor pluggable (SFP transceiver) connector used in a Fibre Channel controller module host port. An example SFP connector is shown below. It is pictorially oriented to align for insertion into the CNC port, such that the connector is flush with the IOM face plate on the enclosure rear panel.

![Figure 30 Sample SFP connector](image)

**NOTE:** See the “4824/4834 controller module — rear panel components” topic within the Setup Guide for an illustration showing an FC SFP installed within the IOM.

Before you begin

**CAUTION:** Mishandling fibre-optic cables can degrade performance. Do not twist, fold, pinch, or step on fibre-optic cables. Do not bend them tighter than a 2-inch radius.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.
CAUTION: To prevent potential loss of access to data, be sure to identify the correct cable and SFP connector for subsequent removal.

Verifying component failure

Transceivers are part of a data path that includes multiple components, such as the transceiver, a cable, another SFP, and an HBA (host bus adapter). A reported fault can be caused by any component in the data path. To identify the location of the fault, check the Link Status/Link Activity LED on the controller module face plate, and check the link status and link activity LEDs on the server. Also, check the cable for kinks, crimping or other possible damage.

TIP: See the AssuredSAN 4004 Series Setup Guide for descriptions of rear panel LEDs.

Removing an SFP module

Perform the following procedure to remove an SFP connector. When removing an FC SFP that has previously limited the port speed—and replacing it with a higher-rated SFP—it is possible, though rare, that auto-negotiation will not enable the higher port speed. Rebooting the array or the host resolves the problem.

1. Disconnect the fibre-optic interface cable by squeezing the end of the cable connector. If the SFP does not have a cable, it should have a plug (retained from installation).

2. SFPs are commonly held in place by a small wire bail actuator. Flip the actuator up.

3. Grasp the SFP between your thumb and index finger, and carefully remove it from the controller module.

Installing an SFP module

Perform the following procedure to install an SFP connector.

1. Locate the SFPs that will be used in the CNC ports.
- If the SFP has a plug, remove it before sliding the connector into the CNC port. Retain the plug.
- If using different SFPs in combination, locate the appropriate SFP pertaining to each target CNC port, and note the port number (0 — 3) into which each SFP will install.
- See the “Changing host-interface settings” topic in the Storage Management Guide for information about configuring CNC ports for use with qualified FC or iSCSI SFP options. Also see the `show ports` and `set host-port-mode` CLI commands within the CLI Reference Guide.

2. Install the SFP and connect the host interface cable per Figure 33 below:
   a. Flip the SFP actuator and revolve it downwards.
   b. Insert the SFP into the CNC port and ensure that it locks securely into place.
   c. Align the fibre-optic interface cable with the duplex jack at the end of installed SFP.

   ![](image)

   **Figure 33** Install the SFP into the CNC port

3. Connect the fibre-optic interface cable to the duplex jack at the end of the SFP connector.

4. Repeat step 1 through step 3 for each SFP requiring installation into a CNC port.

Verifying component operation

View the Link Status/Link Activity LED on the controller module face plate. A blinking LED indicates that no link is detected. Also check the link status and link activity LEDs on the host.

Replacing a 10GbE SFP+ transceiver

This section provides steps for removing and replacing a small form-factor pluggable plus (SFP+ transceiver) connector used in an Internet SCSI (iSCSI) controller host port. SFP+ connectors are similar in appearance to SFP connectors. These transceivers enable 10GbE equipment designs with high port density, based on electrical and mechanical enhancements to SFP specifications developed by the Small Form Factor (SFF) Committee.

Removing and replacing an SFP+ consists of the same basic steps described for removing and replacing an SFP in the preceding section. This procedure refers to the preceding Replacing a Fibre Channel transceiver instructions. When reviewing the procedure as it pertains to the 10Gb iSCSI host ports, note that your particular cables may be either copper or fibre-optic for the SFP+, depending upon how your system was initially configured, and the SFP+ option used.

<table>
<thead>
<tr>
<th>Table 9</th>
<th>Removing and replacing a 10GbE SFP+ transceiver</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To accomplish this sequential process</strong></td>
<td><strong>See the following procedures</strong></td>
</tr>
<tr>
<td>1. Remove SFP+ connector.</td>
<td>a. Before you begin on page 49.</td>
</tr>
<tr>
<td>2. Install the replacement SFP+ connector.</td>
<td>b. Verifying component failure on page 50.</td>
</tr>
<tr>
<td>3. Verify proper operation for the removed and reinstalled component.</td>
<td>c. Removing an SFP module on page 50.</td>
</tr>
</tbody>
</table>

Installing an SFP module on page 50.
Replacing a 1Gb RJ-45 SFP transceiver

This section provides steps for removing and replacing a small form-factor pluggable transceiver connector used in an Internet SCSI (iSCSI) controller host port. The copper RJ-45 connectors are similar in appearance to other SFP connectors.

Removing and replacing an RJ-45 SFP consists of the same basic steps described for removing and replacing an SFP in the preceding FC and 10GbE iSCSI sections. This procedure refers to Replacing a Fibre Channel transceiver. When reviewing the procedure as it pertains to the 1Gb iSCSI host ports, note that this particular SFP does not support an optic option for 1 Gb.

Table 10  Removing and replacing a 1 Gb SFP transceiver

<table>
<thead>
<tr>
<th>To accomplish this sequential process</th>
<th>See the following procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Remove SFP connector.</td>
<td>a. Before you begin on page 49.</td>
</tr>
<tr>
<td></td>
<td>b. Verifying component failure on page 50.</td>
</tr>
<tr>
<td></td>
<td>c. Removing an SFP module on page 50.</td>
</tr>
<tr>
<td>2. Install the replacement SFP connector.</td>
<td>Installing an SFP module on page 50.</td>
</tr>
<tr>
<td>3. Verify proper operation for the removed and reinstalled component.</td>
<td>Verifying component operation on page 51.</td>
</tr>
</tbody>
</table>

NOTE:  See the “4824/4834 controller module — rear panel components” topic within the Setup Guide for an illustration showing an 1 Gb RJ-45 SFP installed within the IOM.
Replacing a storage enclosure chassis

The controller enclosure or expansion enclosure chassis replacement procedure replaces a damaged chassis FRU, which consists of the structural support metal, the exterior sheet metal housing, and the assembled/installed midplane. The procedure includes removing all FRU components from a damaged chassis and installing them into a replacement chassis.

**IMPORTANT:** AssuredSAN 4004 Series storage enclosures using 2U24 or 2U12 chassis are described in FRUs addressing 24-drive enclosures on page 11 and FRUs addressing 12-drive enclosures on page 16. Chassis replacement for 2U48 and 4U56 enclosures is described in Ultra48 and Ultra56 FRU I&R Guides.

Whether your controller enclosure product is a 2U24 or 2U12 model, a fully functional replacement chassis requires the successful removal and installation of the following components:

- Enclosure bezel (covers enclosure front panel)
- All disk drive modules
- Ear components
- Two power supply units of the same compatible model type (both AC or both DC)
  The PSUs must be designed/approved for use with your specific enclosure product.
- One or two I/O modules (of the same model type)

CNC models require the successful removal and installation of qualified SFP options. This procedure makes extensive use of the FRU component procedures described elsewhere in Chapter 2.

Before you begin

⚠️ **CAUTION:** Do not remove the enclosure until you have received the replacement enclosure.

See CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 20.

1. Schedule down time that will allow for shutdown; sixty minutes of replacement work; and restart.
2. Verify the existence of a known/good backup of the system.
3. Record system settings for future use and label all cables.
4. Prepare a suitable static-protected work environment to accommodate chassis replacement.

Verifying component failure

The controller enclosure FRU includes the enclosure’s metal housing and the midplane that connects I/O modules, disk drive modules, and power supply modules. This FRU replaces an enclosure that has been damaged, or whose midplane has been damaged. Often, a damaged midplane will appear as though an I/O module has failed. If you replace an IOM, and it does not remedy the fault, you may need to replace the enclosure.

You can observe enclosure health (front panel and rear panel) using management interfaces to verify enclosure/component failure or enclosure/component operation (see Using management interfaces on page 57 for more information).

Preparing to remove a damaged storage enclosure chassis

Because you are removing and replacing an entire storage enclosure, neither the hot-swap capability that applies to replacing individual redundant FRUs in an operational storage enclosure, nor the hot-add of a drive enclosure to an operational storage system, apply to this procedure.

1. Stop all I/O from hosts to the system. See Stopping I/O on page 25.
3. Power off the system (controller enclosure first; expansion enclosures next). See Power supply units on page 39, and refer to the power cycling procedures for your particular power supply model.
To accomplish this sequential process | See the following procedures
---|---
1. Remove the enclosure bezel to provide access to front panel components. | a. Figure 11 on page 22 (2U24 chassis).  
   b. Figure 12 on page 22 (2U12 chassis).
2. Remove disk drive modules from the damaged chassis. | a. Before you begin on page 33.  
   b. Removing a disk drive module on page 34.
3. Remove the ear components from the damaged chassis. | a. Before you begin on page 45.  
   b. Removing ear components on page 47.
4. Remove power and data cables. | a. Figure 31 on page 50 (cabling aspects).  
   b. Removing a damaged storage enclosure chassis from the rack on page 55 (step 1).
5. Remove the damaged storage enclosure chassis from the rack. | Removing a damaged storage enclosure chassis from the rack on page 55.
6. Remove the power supply units from the damaged chassis, and install them in the replacement chassis. | a. Before you begin on page 38.  
   b. Power supply units on page 39.  
   c. Removing a power supply unit on page 42.  
   d. Installing a power supply unit on page 43.
7. Remove each IOM from the damaged chassis, and install it in the replacement chassis. | a. Before you begin on page 23.  
   b. Removing a controller module or expansion module on page 27.  
   c. Installing a controller module or expansion module on page 29.
8. Remove each FC SFP from the damaged chassis, and install it in the replacement chassis (Fibre Channel models only). | a. Before you begin on page 49.  
   b. Removing an SFP module on page 50.  
   c. Installing an SFP module on page 50.
9. Remove each 10GbE SFP from the damaged chassis, and install it in the replacement chassis (10GbE iSCSI models only). | Replacing a 10GbE SFP+ transceiver on page 51.  
   Also see Steps 8a — 8c immediately above.
10. Remove each 1 Gb SFP from the damaged chassis, and install it in the replacement chassis (1 Gb iSCSI models only). | Replacing a 1Gb RJ-45 SFP transceiver on page 52.  
   Also see Steps 8a — 8c above.
11. Install ear kit components on the replacement chassis ear. | Installing ear kit components on page 48.
12. Install the replacement storage enclosure chassis in the rack. | Installing the replacement storage enclosure in the rack on page 55.
13. Install disk drive modules in the replacement chassis. | a. Connecting a power cable on page 44.  
   b. Completing the process on page 56.
   b. IOMs—Verifying component operation on page 30.  
   c. PSUs—Verifying component operation on page 45.  
   d. SFPs (if applicable)—Verifying component operation on page 51.  
   e. Verify PFU enabled (if applicable)—Configuring partner firmware update on page 24.
15. Verify proper operation for all removed and installed FRU components.
Within the replacement enclosure, the IOM(s) and IOM blank—if applicable—must be reinstalled into the same IOM slots from which they were extracted from the damaged enclosure.

If your enclosure model does not use CNC ports, ignore this step.

Removing a damaged storage enclosure chassis from the rack

This section provides a procedure for removing a damaged storage enclosure chassis from its rack location.

⚠️ CAUTION: It is recommended that all disk drive modules be removed before removing the enclosure. If this is not possible, two people are required to move the enclosure. See Removing a disk drive module on page 34 and FDE considerations on page 32.

1. Disconnect the power cables and data cables between devices as needed:
   a. Between the cascaded enclosures.
   b. Between the controller and peripheral SAN devices.
   c. Between the controller and the host.
2. Make sure the ear components are removed. See Removing ear components on page 47.
3. Remove the retaining screws that secure the front and rear of the enclosure chassis to the rack and rails.
4. Maintaining a level position, carefully slide the enclosure chassis from the rack.
5. Place the chassis on a work surface near the replacement enclosure chassis, the removed disk drive modules, ear components, and screws.
6. Remove the side bracket from each side of the damaged enclosure chassis, and retain these rackmount items with the other components for future use.

Installing the replacement storage enclosure in the rack

This section provides a procedure for installing the replacement enclosure in its rack location.

⚠️ CAUTION: It is recommended that all disk drive modules be removed before lifting the enclosure. If this is not possible, two people are required to move the enclosure. See Removing a disk drive module on page 34 and FDE considerations on page 32.

NOTE: Refer to Rackmount Bracket Kit Installation or 2-Post Rackmount Bracket Kit Installation used with your product for the correct procedure and mounting hardware.

1. Attach side brackets (standard rackmount installation) or main brackets (2-post rackmount installation) on the replacement enclosure chassis.
2. Support the bottom of the enclosure chassis. Carefully lift/align the chassis and while maintaining a level position for the enclosure, slide it into the rack.
3. Using the appropriate mounting hardware, secure the enclosure chassis to the rack.
4. Install the ear components. See Installing ear kit components on page 48.
5. Using the applicable retaining screws, secure the front and rear or the enclosure chassis to the rack and rails.
6. Attach the enclosure bezel to the front panel of the enclosure:
   • For 2U24 enclosures, see Figure 11 on page 22 for bezel attachment and removal instructions.
   • For 2U12 enclosures, see Figure 12 on page 22 for bezel attachment and removal instructions.
Completing the process

This section provides a procedure for ensuring that the FRU components installed in the replacement controller enclosure chassis function properly.

1. Reconnect data cables between devices, as needed, to return to the original cabling configuration:
   • Between cascaded enclosures.
   • Between the controller and peripheral or SAN devices.
   • Between the controller enclosure and the host.
2. Reconnect power cables to the controller enclosure. See Connecting a power cable on page 44.
3. Turn on the power switch to each power supply module if they are equipped with power switches.

**NOTE:** For powering-on AC PSUs with or without a power switch, and DC and AC PSUs with a power switch, see Power supply units on page 39.

Verifying component operation

1. Restart system devices in the following sequence. Allow time for each device to complete its Power On Self Tests (POST) before proceeding:
   a. Expansion enclosure(s)
   b. Controller enclosure
   c. Host (if powered down for maintenance)
2. Perform a rescan to force a fresh discovery of all expansion enclosures connected to the controller enclosure. This step clears the internal SAS layout information, reassigns enclosure IDs, and ensures the enclosures are displayed in the proper order. Use the CLI, the SMC, or RAIDar to perform the rescan:
   To perform a rescan using the CLI, enter the following command:
   ```
   rescan
   ```
   You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See TIP bullets regarding CLI “default management mode” and “current management mode” page 24.
   To rescan using the SMC (v3):
   a. Verify that both controllers are operating normally.
   b. In the System topic, select Action > Rescan Disk Channels.
   c. Click Rescan.
   To rescan using RAIDar (v2):
   a. Verify that both controllers are operating normally.
   b. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels.
   c. Click Rescan.
   See “Correcting enclosure IDs” in the Setup Guide for additional information.

Using LEDs

View LEDs on the front and rear of the enclosure (see “LED descriptions” within the AssuredSAN 4004 Series Setup Guide for more information).

Verify front panel LEDs:
- Verify that the Enclosure ID LED (located on the left ear) is illuminated green.
- Verify that the FRU OK and Temperature Fault LEDs are illuminated green, and that the Fault/Service Required LED is off (all three LEDs are located on the right ear).
- For LFF disks, verify that the Power/Activity LED (bottom LED on front of disk) is illuminated green or blinking green.
Remove the enclosure bezel to view disk LEDs. Attach the bezel when finished viewing disk LEDs.
For SFF disks, verify that the Power/Activity LED (left LED on front of disk) is illuminated green or blinking green.

Remove the enclosure bezel to view disk LEDs. Attach the bezel when finished viewing disk LEDs.

Verify rear panel LEDs:

- Verify that each power supply module’s Input Source Power Good LED (top LED on PSU) is illuminated green.
- Verify that the FRU OK LED on each IOM face plate is illuminated green, indicating that the module has completed initializing, and is online.

Using management interfaces

In addition to viewing LEDs as described above, you can use management interfaces to monitor the health status of the system and its components, provided you have configured and provisioned the system, and enabled event notification (see “Getting Started” within the AssuredSAN 4004 Series Storage Management Guide for more information).

Select from the following methods to verify component operation:

- Use the SMC (v3) or RAIDar (v2) to check the health icons/values of the system and its components to either ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar use health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.

- As an alternative to using the SMC or RAIDar, you can run the `show system` command in the CLI to view the health of the system and its components. If any component has a problem, the system health will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.

- Monitor event notification — With event notification configured and enabled, you can view event logs to monitor the health of the system and its components. If a message tells you to check whether an event has been logged, or to view information about an event in the log, you can do so using the SMC, RAIDar, or the CLI. Using either the SMC or RAIDar, you would view the event log and then hover over the event message to see detail about that event. Using the CLI, you would run the `show events detail` command (with additional parameters to filter the output) to see the detail for an event (see “Alphabetical list of commands > show events” within the AssuredSAN 4004 Series CLI Reference Guide for more information about command syntax and parameters).
Index

Numerics
2U12 10
2U24 10
4004 Series enclosures (2U12/2U24) 7
product overview table 10

A
audience 7

B
bezel
ear bezel
  2U12 46
  2U24 45
enclosure bezel
  2U12 19
  2U24 14

C
chassis
  2U12 16
  2U24 11
CLI
  accessing 10
  Command-line Interface 10
default password 10
default user name 10
  more information 10
  show FRUs (show frus) command 10
controller modules
  4-port 1 Gb iSCSI 7
  4-port 10GbE iSCSI 7
  4-port 12 Gb SAS 7
  4-port 8/16 Gb FC 7
conventions
document 8

D
disk drives
  LFF 16
  SFF 11
document
  conventions 8
  prerequisite knowledge 7
  related documentation 8

E
ear bezel kits
  2U12 46
  2U24 45
electrostatic discharge 20
grounding methods 20
precautions 20
Ethernet 8

F
firmware
dual controller 24, 25
update 31
FRUs
  available for 4004 Series 10
  12-drive enclosure 16
  24-drive enclosure 11
determining FRU identifiers 10
component item tables 10
enclosure assembly
  2U12 18
  2U24 13
illustrated parts breakdown
  2U12 17
  2U24 12
internal components sub-assembly
  2U12 18
  2U24 13

H
host interface protocols
  FC 8
  iSCSI 8
  SAS 8
hosts
  stopping I/O 25

L
LEDs
  controller module 25
  enclosure
    rear panel 57
  enclosure status
    front panel 56
  power supply unit (PSU)
    AC 45
    DC 45

M
management interfaces
  Command-line interface 57
  monitor event notification 57
  RAIDar 57
  using 57

P
partner firmware update (PFU) 24
power supply unit (PSU) 37
AC model compatibility 43
AC PSU with power switch 41
AC PSU without power switch 38
DC PSU 41
power cable 44
AC 44
DC 44
verifying component failure 38
prerequisite knowledge 7
procedures
general precaution 20
replacing a 1 Gb RJ-45 SFP 52
replacing a 10GbE SFP+ 51
replacing a controller or expansion module 23
replacing a disk drive module 32
replacing a Fibre Channel SFP 49
replacing a PSU 37
replacing a storage enclosure chassis 53
components (common) 53
components (model-specific) 53
damaged chassis removal 55
replacement chassis installation 55
replacing ear bezels 45

R
related documentation 8

S
SFP transceiver
  Fibre Channel controller host port 49
  fibre-optic cable 49
  small form-factor pluggable 49
SFP+ transceiver
  1 Gb iSCSI controller host port 52
  10GbE iSCSI controller host port 51
  small form-factor pluggable plus 51, 52